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Any questions?

A miracle

n
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Let's take a survey.

]
.
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Survey questi

Have you ever purchased something over the web?

eAll
oAlmost all
o Most
oSome

oA few
oNone

n
.
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Do you regularly drive an automobile, motorcycle, etc.?

oAll
eAlmost all
o Most
oSome

oA few
oNone

n
.
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Survey ques

Have you used Emacs?

oAll
oAlmost all
o Most
eSome

oA few
oNone

n
.
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Survey ques

Have you used that other editor?

oAll
oAlmost all
o Most
eSome

oA few
oNone

n
.
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Have you used oXygen?

oAll
oAlmost all
e Most
oSome

oA few
oNone

n
.
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Survey ques

Have you used Notepad?

oAll
oAlmost all
o Most
oSome

oA few
oNone

n
.
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Survey ques

Have you used Arbortext Editor?

oAll
oAlmost all
o Most
eSome

oA few
oNone

n
.
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Survey question

kS

Have you used a recent version of Microsoft Word?

oAll
eAlmost all
o Most
oSome

oA few
oNone

n
.
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Survey ques

Have you commented on a weblog?

oAll
eAlmost all
o Most
oSome

oA few
oNone

n
.
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What do we really

What will it take to get (end user) XML editors that people will
use?

® What do we mean by XML?
® What do we mean by editor?
® What do we mean by people?

'.MarkLogic '
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<purchase/>

n
.
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What do we mean by X

<purchase/>
<drive/>
<emacs/>

Sidebar

® Edit only well-formed XML documents?
® Edit any XML fragment?
® Edit XML-like documents that aren't well-formed or are

momentarily not well-formed?
® [s ~/.bashrc or c:\autoexec.bat a not-well formed XML file?

n
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What do we me

<purchase>all</purchase>
<drive>almost</drive>
<emacs>some</emacs>

n
.
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What do we me

<survey>
<purchase>all</purchase>
<drive>almost</drive>
<emacs>some</emacs>

n
.
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What do we m

® Namespaces ...

® Mixed content ...

® HTML, DocBook, TEI, DITA, ...
[ |

[ |

Arbitrary XML

n
.
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What do we mean by X
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Survey says!

<survey>
<purchase>all</purchase>
<driveralmost</drive>
<emacs>some</emacs>
<other>some</other>
<oxygen>most</oxygen>
<notepad>few</notepad>
<epic>some</epic>
<msword>almost</msword>
<comment>almost</comment>

</survey>

n
.
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What do we mea

OO O
\\/ Editing XML - Wikipedia, the

€ 9 C © en.wikipedia.org/w/index.php?title=XML&action=edit wl P S © & U A\

& Nwalsh Mytalk My preferences My watchlist My contributions Logout [7)

Article Discussion Read Edit View history |503"Ch Q|

Editing XML

WIKIPEDIA " .
‘The Free Encyclopedia From Wikipedia, the free encyclopedia
@3 [N\] » Advanced ) Special characters » Help » Cite
Main page BI] Eed pec p
Contents "Extensible Markup Language™ ("XML") is a set of rules for encoding documents in [[machine-readable]] form. It

Featured content is defined in the XML 1.0 Specification<ref>{{cite web|url=http://www.w3.org/TR/REC-xml [title=XML 1.0 [)
Specification |publisher=W3.org |date= |accessdate=2010-08-22}}</ref> produced by the [[W3C]], and several

other related specifications, all [[gratis]) [[open standard]]s.<ref>{{cite web|title=W3C DOCUMENT

LICENSE|url=http://www.w3.org/Consortium/Legal /2002 /copyright-documents-20021231}} < /ref>

Current events
Random article
Donate to Wikipedia

The design goals of XML emphasize simplicity, generality, and usability over the [[Internet]). <ref name="XML

w Interaction . . - -
Goals">{{cite web|title=XML 1.0 Origin and Goals|url=http://www.w3.org/TR/REC-xml/#sec-origin-

Help goals|accessdate=July 2009}}</ref> It is a textual data format with strong support via [[Unicode]] for the \J
About Wikipedia languages of the world. Although the design of XML focuses on documents, it is widely used for the

Community portal representation of arbitrary [[data structures]], for example in [[web service]]s.

Recent changes

Many [[application programming interfaces]] (APIs) have been developed that software developers use to process

n ikipedi
Eoalid el XML data, and several [[XML schema|schema systems]] exist to aid in the definition of XML-based languages.

» Toolbox
{{As of|2009}}, hundreds of XML-based languages have been developed,<ref name="Cover pages list">{{cite

web|url=http://xml.coverpages.org/xmlApplications.html|title=XML Applications and Initiatives}}</ref>

including [[RSS]], [[Atom (standard)|Atom]], [[SOAP]], and [[XHTML]). XML-based formats have become the default
for most office-productivity tools, including [[Microsoft Office]] ([[Office Open XML]]), [[OpenOffice.org]]
([[OpenDocument])), and [[Apple Computer|Apple]]'s [[iWork]). <ref>{{cite web|title=Introduction to iWork
Programming Guide. Mac OS X Reference
Library|publisher=Apple|url=http://developer.apple.com/mac/library/documentation/AppleApplications/Concep
tual/iWork2-0_XML/Chapter01/Introduction.html}}</ref> A
)
==Key terminology== W
Content that violates any copyrights will be deleted. Encyclopedic content must be verifiable.

By clicking the "Save Page" button, you agree to the Terms of Use, and you irrevocably agree to release
your contribution under the CC-BY-SA 3.0 License and the GFDL. You agree that a hyperlink or URL is
sufficient attribution under the Creative Commons license.

Edit summary (Briefly describe the changes you have made)

) This is a minor edit (what's this?) () Watch this page
(‘save page ) (‘Show preview ) (‘Show changes ) Cancel | Editing help (opens in new window)

If you do not want your writing to be edited, used, and redistributed at will, then do not submit it here. All text that you did not write
yourself, except brief excerpts, must be available under terms consistent with Wikipedia's Terms of Use before you submit it.

[ Insert 4] —— e riszess—x+y— —-§ Sign your posts on talk pages: ~~~~
Cite your sources: <ref></ref>

Please note:

« When you click Save, your changes will immediately become visible to everyone. If you wish to run a
test, please edit the Sandbox instead.

N

]
.
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What do we mean by edi

~ N

EAXSLT - Mark Logic Wiki - C

€ > C (X bups://wiki.marklogic.com/pages/editpage.action?pageld=9511858 w ﬁ q S © e U A\

Dashboard » Mark Logic Wiki » ... Browse v Norman Walsh ~
» XSLT and XQuery » XSLT » Edit Page

®'MarkLogic  XSLT

Rich Text Wiki Markup ~Preview (Save) {Cancel)

Paragraph ~ B 7 U ¢ A~ |4

-

| Insert ~ &2

What is XSLT?

XSL Transformations (XSLT 2.0) is a language for transforming XML documents into other XML documents,
A7 A A i A f4o £oommmt - -2 ~f 3 book using XSL-FO, or you might want to take a «

Go to Link Location  Edit Link Location  Unlink

- but on anything that can be made to look like XML:
database tables geographical mformatlon systems, file systems, anything from which your XSLT processor
instance. In some cases an XSLT 2.0 processor might also be able to work directly from a database of XDM
ability to operate on multiple input files in multiple formats, and to treat them all as if they were XML files, is v
shared with XQuery, and with anything else using XPath 2.0

Specialist

List of specialists for this domain:

APttt /2 kspace)

Maintainer

Hint: press M to open the image browser.

What did you change? (L) Minor change? (no notifications will be sent)

Location: Mark Logic Wiki > XSLT and XQuery Edit

Restrictions: Edit

=
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What do we mean

(e NéVé)

<e> chO1l.xml

—
f‘

[{chapter xmlns="http://docbook.org/ns/docbook
xmlns:cx="http://xmlcalabash.com/ns/extensions
xmlns:xi="http://ww.w3.0rg/2001/XInclude
xmlns:xlink="http://ww.w3.0rg/1999/xlink
xmlns:p="http://ww~.w3.0org/ns/xproc
version="5.0-xproc” xml:id="introduction">

<info>

<title-Introduction</title

</info

<para-In this chapter, we'll fill in some background about pipelines o

and get you up to speed on the concepts before we dive into the actual
features of XProc. We're going to assume that you're familiar with
XML: you're comfortable the vocabulary of tags and attributes, parsing
and validation, and that you've used an XML application or two: XSLT,
for example.</para

<section xml:id="whatis
<title-What's a pipeline?</title-

<para-At a high level of abstraction, a pipeline is what you get
whenever the output of one process feeds into the input of another.
If you work with XML, you've probably already used pipelines

even if you didn't think about them in those terms. If you validate
a document and then transform it, or if you apply XInclude and then
validate, or if you use XSLT to run two differen transformations,
those are all simple “pipeline” operations.-/para-

<para-In another context, pipelines are a common feature of Unix
command lines, for example:-/para-

<screen-cat ch@l.xml | grep "41t:para" | wc -l</screen
<para-What that says is:</para-

orderedlist
<listitem
<para-Run the <command-cat</command- command over
filename-ch@l.xml-/filename-. That will display the contents of the file.
</para-
</listitem
listitem
<para-The “|" symbol means that instead of displaying those lines in
the shell window, that output will become the input to the
command-grep</command- command. What <command-grep-/command- will do
is display all the lines that contain “<literal-&!t:para</literal-"
and discard all the rest.-/para
/listitem
<listitem
<para-Finally, with another “|", the output of <command-grep-/command- will
become the input to <command-wc</command-. The <command-wc</command- command
counts the words in a file, but we gave it the -option--l</option- option, so
it will count the lines instead.-/para
/listitem
</orderedlist

para-What this pipeline does is print the number of paragraphs in the
document:</para

screen-?7FIXME:?7</screen-

<para-By using a pipeline we've taken three useful utilities and
composed them together to create a pipeline that will count the
approximate number of paragraphs we've used in all the XML documents .
in the current directory. I say approximately because those are all line-based M

-&U:@--- ch@l.xml Top L1 SVN-17 [(nXML Valid yas)]
Mark set

n
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& XED 0.4.1.1: F:/work/xml/xed/dist/xed.xml
File Edit Options Help

<doc>
<head>

<title>XED: An XML document instance editor</title>

<author>Henry $. Thompson</author>

<author>HCRC Language Technology Group</author>

<author>University of Edinburgh</author>

<date>11 July 1998</date>
</head>
<body>

<div>

<title>XED Functionality</title>

<p>XED iz a text editor for XML document instances. It is designed to
gupport hand-authoring of small-to-medium size XML documents, and is optimised
for keyboard input. It works <emph>very</emph> hard to ensure that you cannot
produce a non-well-formed document. Although it neither parses DTDs in detail

=
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What do we mean k

N ala

<e> ch01.xml [/projects/xproc/src/ch01l.xml] - <oXygen/> XML Editor

- rm—r— e

D]
[

“Chapter 1: Introduction

In this chapter, we'll fill in some background about pipelines and get you up to speed on the concepts before we dive
into the actual features of XProc. We're going to assume that you're familiar with XML: you're comfortable the
vocabulary of tags and attributes, parsing and validation, and that you've used an XML application or two: XSLT, for
example.

“Section 1.1: What's a pipeline?

At a high level of abstraction, a pipeline is what you get whenever the output of one process feeds into the input of
another. If you work with XML, you've probably already used pipelines even if you didn't think about them in those
terms. If you validate a document and then transform it, or if you apply XInclude and then validate, or if you use
XSLT to run two differen transformations, those are all simple “pipeline” operations.

In another context, pipelines are a common feature of Unix command lines, for example:
‘cat chOl.xml | grep "<para" | wc -1
What that says is:

1. Run the bcat 4 command over Pch01.xml 4. That will display the contents of the file.

2. The “I" symbol means that instead of displaying those lines in the shell window, that output will become the inpi
to the Pgrep < command. What Pgrep 4 will do is display all the lines that contain “P<parad” and discard all
the rest.

3. Finally, with another “I”, the output of Pgrep 4 will become the input to Pwe 4. The bwed command counts the
words in a file, but we gave it the P14 option, so it will count the lines instead.

What this pipeline does is print the number of paragraphs in the document:

| 22FIXME:??

By using a pipeline we've taken three useful utilities and composed them together to create a pipeline that will count
the approximate number of paragraphs we've used in all the XML documents in the current directory. I say
approximately because those are all line-based commands and XML isn't really line based. Our XML editor might
have saved our XML files with great big long lines so that there's more than one “P<para>..</para>4" per line
which would throw off the counts.

Part of the power of Unix comes from the fact that it provides a large and useful vocabulary of focused commands an

a mechnanism for easily composing them. By the same token, the XML technology stack provides a large and useful =
vocabulary of “commands™: parsing, validation, transformation, XInclude, XML Base, escaping and unescaping

markup, document comparison, etc. What's historically been missing is a standard, easy to use composition mechnais!

Which isn't meant to suggest that XProc invented the notion of XML pipelines. Far from it, in fact. For as long as the
have been APIs for processing XML, there have been mechanisms for constructing pipelines. One of the explicit goa
of the XProc development exercise was to invent as little as possible: the committee attempted to survey the landscap
of existing pipeline technologies and standardize the common core. The key features that XProc introduces are
standardization and ease of use.

Through standardization we hope to foster the development of interoperable pipelines. The pipelines that yourunin =~ =
your web framework should also run on my command line and the pipelines that run on my command line should als
run in your XML editor.

The ease of use goal is met, we hope, by providing an XML vocabulary for describing pipelines. That's what XProc |4
really is. We hope that an analogy with XSLT is apt. Before XSLT, it was obviously possible for programmers to  |v 3

[C Y« S
o=@ E [Jing] IDREF "xcalabash" without matching ID
L I - Author |
| /projects /xproc/src/ch01.xml | B XPath - failed |u+0000 |

n
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What do we me

®00 <> ch01.xml [/projects/xproc/src/ch01l.xml] - <oXygen/> XML Editor

[@-choLaxmit—x] b
lv <chapter, xmin :.—'http //docbook . org/ns/docbook" b~

xmlns:cx="http://xmlcalabash.com/ns/extensions"
3 xmlns:xi="http://www.w3.0rg/2001/XInclude"
4 xmlns:xlink="http://ww.w3.0rg/1999/x1ink"
5 xmlns:p="http://ww.w3.org/ns/xproc"
6 ersion="5.@-xproc" xml:id="introduction">
7= <info>
8 <title>Introduction</title>
9 </info>
10
11 = <para>In this chapter, we'll fill in some background about pipelines
12 and get you up to speed on the concepts before we dive into the actual
13 features of XProc. We're going to assume that you're familiar with
14 XML: you're comfortable the vocabulary of tags and attributes, parsing
15 and validation, and that you've used an XML application or two: XSLT,
16 for example.</para>
17
18 = <section xml:id="whatis">
19 <title>What's a pipeline?</title>
20
21 v <para>At a high level of abstraction, a pipeline is what you get
22 whenever the output of one process feeds into the input of another.
23 If you work with XML, you've probably already used pipelines
24 even if you didn't think about them in those terms. If you validate
25 a document and then transform it, or if you apply XInclude and then
26 validate, or if you use XSLT to run two differen transformations,
27 those are all simple “pipeline” operations.</para>
28
29 - <para>In another context, pipelines are a common feature of Unix
30 command lines, for example:</para>
31
32 <screen>cat ch@l.xml | grep "&lt:para" | wc -l</screen>
33
34 <para>What that says is:</para>
35
36 v <orderedlist>
37 - <listitem>
38 = <para>Run the <command>cat</command> command over
39 <filename>ch@l.xml</filename>. That will display the contents of the file.
a0 </para>
41 </listitem>
42+ <listitem> —
43 = <para>The “|” symbol means that instead of displaying those lines in
44 the shell window, that output will become the input to the
45  <command>grep</command> command. What <command>grep</command> will do
46 1is display all the lines that contain “<literal>&lt:para</literal>”
47 and discard all the rest.</para>
48  </listitem>
49 - <listitem>
50 = <para>Finally, with another “|”, the output of <command>grep</command> will
51 become the input to <command>wc</command>. The <command>wc</command> command
52 counts the words in a file, but we gave it the <option>-l</option> option, so
53 it will count the lines instead.</para> —
54  </listitem>
55  </orderedlist> s
56 v ¥
YT S

o=@ E [Jing] element "att" not allowed anywhere; expected the element end-tag, text or element "abbrev",

-m- Grid Author |

| /projects /xproc/src/ch01.xml | B XPath - failed |u+003C [ 11 | Modified

accel", "acronym", "addre

]
.
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‘<§ ch01.xml [/projects/xproc/src/ch01l.xml] - <oXygen/> XML Editor

@xml:1d

/projects /xproc/src/ch0l.xml M XPath - failed

]
.
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What do we mean by

@ Arbortext Editor with Styler, - ch01.xml
File Edit Find Yiew Insert Entities Table Tools Styler Format Window Help

Chapter 1 Introduction 1

In this chapter, we'll fill in some background about pipelines and get you up to speed on the concepts before we dive into
the actual features of 2{Proc. We're going to assume that you're familiar with 3ML: you're comfortable the vocabulary of
tags and attributes, parsing and validation, and that you've used an XML application or two: 3ISLT, for example.

Section 1.1 What's a pipeline?

At a high level of abstraction, a pipeline is what you get whenever the output of one process feeds into the input of
another. If you work with XML, you've probably already used pipelines even if you didn't think about them in those
terms. If you validate a document and then transform it, or if you apply XInclude and then validate, or if you use Z{SLT to
run two different transformations, those are all simple “pipeline” operations.

In another context, pipelines are a common feature of Unix command lines, for example:
cat ch0l.xml | grep "<para” | wg -1
What that says is:
1. Runthe cat command over ch01. xml. That will display the contents of the file.

2. The “|" symbol means that instead of displaying those lines in the shell window, that output will become the input to
the grep command. What grep will do 1s display all the lines that contain “<para” and discard all the rest.

3. Finally, with another |7, the output of grep will become the input to we, The we command counts the words in a
file, but we gave it the -1 option, so it will count the lines mstead.

TWhat this pipeline does 1s print the number of paragraphs in the document:

22FIQUE: 22
By using a pipeline we've taken three useful utilities and composed them together to create a pipeline that will count the
approximate number of paragraphs we've used in all the XML documents in the current directory. I say approximately
because those are all line-based commands and XML 1sn't really line based. Our JML editor might have saved our
L files with great big long lines so that there's more than one “<para>..</para>” per line which would throw off
the counts.

Part of the power of Unix comes from the fact that it provides a large and useful vocabulary of focused commands and a
mechanism for easily composing them. By the same token, the 2L technology stack provides a large and useful
vocabulary of “commands™ parsing, validation, transformation, 2dnclude, 2L Base, escaping and unescaping markup,

v

Command:

I TRK | EXT | O¥R | READ | MOD | OFF | CAP | MUM

n
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What do we mean b

@ Arbortext Editor, with Styler - ch01.xml
File Edit Find VYiew Insert Entities Table Tools Styler

Format ‘Window Help

| chapter xmins:cx="http: ixmicalabash.cominsiextensions" xmins: xi="hitp: MAernewe w3 .orgf2001 ZXInclude” xmins: xlink="http: A w3 .orgf 9990NInk" xi1 ]

me>Chapter 1 Introduction @ 4

[para > In this chapter, we'll fill in some background about pipelines and get you up to speed on the concepts before we

dive into the actual features of 3 Proc. We're going to assume that you're familiar with 3 L: you're comfortable the

vocabulary of tags and attributes, parsing and validation, and that you've used an XL application or two: ZSLT, for
example.

[section xmlid="whatis" >

[= ) Section 1.1 What's a pipeline?

[para» At a high level of abstraction, a pipeline is what you get whenever the output of one process feeds into the input of

another. If you work with 3L, you've probably already used pipelines even if you didn't think about them in those

terms. If you validate a document and then transform it, or if you apply XInclude and then validate, or if you use Z{SLT to
run two different transformations, those are all simple “pipeline” operations.
[para > In another context, pipelines are a common feature of Unix command lines, for example:

cat. ch0l.xml | grep "<para” | yg -1

[para_, What that says is:

1. [para »Runthe [command ycat command over [fiename »ch01 . xml (Fiename | That will
display the contents of the file.

2. [para »The “|" symbol means that instead of displaying those lines in the shell window, that output will
become the input to the [command ) grep {command | command. What [command ) grep {command | will do is
display all the lines that contain “ [lteral ) <para (lteral " and discard all the rest.

3. [para)Finally, with another “|”, the output of [command ) grep command | will become the input to
[command ywe {command |. The [command ywe {command | command counts the words in a file, but we gave it the
[option -1 {option | option, so it will count the lines instead.

[para > What this pipeline does is print the number of paragraphs in the document:

[para > By using a pipeline we've taken three useful utilities and composed them together to create a pipeline that will

count the approximate number of paragraphs we've used i all the XML documents in the current directory. I say

approximately because those are all line-based commands and 3L isn't really line based. Our 2L editor might have
saved our XML files with great big long lines so that there's more than one “[ftersl ) <para>..</ para> {iteral | per
line which would throw off the counts.

[para > Part of the power of Unix comes from the fact that it provides a large and useful vocabulary of focused

< |

&
[

Command:

Ichapterlinfotitle TRK | EXT | OVR | READ | MOD | OFF | CAP | NUM

]
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®00 | Documentl (@)

&J'ES}E@V@LD@QKD'@'“ [ﬁ_/‘_}ﬁ (Qx~ [ search in Document ) »

\ } #A Home [ Layout ] Document Element; } Tables [ Ch;m | SmartArt | Review | Developer | | ~ 2~
Font Paragraph Styles

Times [+][10 [+]|As| A~|| A2~ [@j = = 'JW—-‘?—-) AaBbCcDdE
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C T O R T I Y

Chapter 1: Introduction

In this chapter, we'll fill in some background about pipelines and get you up to
speed on the concepts before we dive into the actual features of XProc. We're going
to assume that you're familiar with XML: you're comfortable the vocabulary of tags
and attributes, parsing and validation, and that you've used an XML application or
two: XSLT, for example.

1l oo

2] 0o

Section 1.1: What’s a pipeline?

At a high level of abstraction. a pipeline is what you get whenever the output of one process feeds into the

input of another. If you work with XML you ve pmbably alneady used plpelmes even 1f you dldnl thmk
about lhem in lhose terms. If vou yalidate 3 Al

3 o

In another context, pipelines are a common feature of Unix command lines. for example:

[cat chol.xml | grep "<para” | wg -1

P Y—

‘What that says is:

Run the cat command over ch01.xml. That will display the contents of the file.

The “I” symbol means that instead of displaying those lines in the shell window, that output will
become the input to the grep command. What grep will do is display all the lines that contain
“<para” and discard all the rest.

[ 3. Finally, with another “I”, the output of grep will become the input to wg, The w¢ command counts
L the words in a file, but we gave it the =1 option, so it will count the lines instead.

[

g5l oo

‘What this pipeline does is print the number of paragraphs in the document:

Bl oo

[zz2FIxmME; 22

By using a pipeline we've taken three useful utilities and composed them together to create a pipeline that
will count the approximate number of paragraphs we've used in all the XML documents in the current
directory. I say approximately because those are all line-based commands and XML isn't really line based.
Our XML editor might have saved our XML files with great big long lines so that there's more than one
“<para>.</para>" per line which would throw off the counts.

72l

Part of the power of Unix comes from the fact that it provides a large and useful vocabulary of focused
commands and a mechnanism, for easily composing them. By the same token, the XML technology stack
prowdes a Ia.rge and useful \'ocabulary of “commands™: parsing. \'alldauon (ransformauon &m;mgg
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Aside:

Or, “is this what we mean by XML!?”
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<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<w:document xmlns:wpc="http://schemas.microsoft.com/office/word/2010/wordprocessingCanvas”
xmlns:mo="http://schemas.microsoft.com/office/mac/office/2008/main"
xmlns:mc="http://schemas.openxmlformats.org/markup-compatibility/2006"
xmlns:mv="urn:schemas-microsoft-com:mac:vml" xmlns:o="urn:schemas-microsoft-com:office:office"
xmlns:r="http://schemas.openxmlformats.org/officeDocument/2006/relationships”
xmlns:m="http://schemas.openxmlformats.org/officeDocument/2006/math"
xmlns:v="urn:schemas-microsoft-com:vml"
xmlns:wpl4="http://schemas.microsoft.com/office/word/2010/wordprocessingDrawing"”
xmlns:wp="http://schemas.openxmlformats.org/drawingml /2006 /wordprocessingDrawing"
xmlns:wl0="urn:schemas-microsoft-com:office:word"
xmlns:w="http://schemas.openxmlformats.org/wordprocessingml/2006/main"
xmlns:wl4="http://schemas.microsoft.com/office/word/2010/wordml"
xmlns:wpg="http://schemas.microsoft.com/office/word/2010/wordprocessingGroup"”
xmlns:wpi="http://schemas.microsoft.com/office/word/2010/wordprocessingInk"
xmlns:wne="http://schemas.microsoft.com/office/word/2006/wordml"
xmlns:wps="http://schemas. microsoft.com/office/word/zo10/wordprocessingshape" mc:anorable "wl4
wpld"><w:body><w:p w:rsidr-"00BEODF7" w:rsidiDefault="008E1225" w:rsidP-"008E1225"><w:pPr><w:pstyle ot
wival="Title"/></w: PPr><wir><w: t>Chapter 1: Introduction</w: t></w r></w: PrEWIp Wirs idr="008E1225"
wirsidrRDefault="008E1225" w:rsidr="008E1225"><wi:r><w:t xml:space="preserve">In this chapter, we'll fill
in </wit></wirr<w:ir><w:t xml:space-"preserve'>some background about pipelines </w:t></w:i:r><w:r><w:t>and
get you up to speed on the concepts before we dive into the actual(/w:t></w:r><w:r><w:t
1: space preserve "> <fwitr</wirr<wir><w:t xml:space-"preserve">features of </w:t></w:r><w:proofErr
wi:type spellstart />ewir><w:t>XProc</w: t></w r><w: proo!Brr w:type "spellEnd"/><w:r><w:t>. We're going to
assume that you're familiar with</wit></wirz<w:i:r><w:t xml:space-"preserve"> </wit></wir><w:r><w:t>XML:
you're comfortable the vocabulary of tags and attributes, parsing</wit></wirr<wir><w:t
wmlispaces"preserve"> </wit></wir><w:r><w:t>and validation, and that you've used an XML application or
two: XSLT,</wit></wirr<wir><w:t xml:space-"preserve"> </wit></wirr<w:r><w:t>for
example.</w:t></wir></wip><w:ip w:rsidrR="008E1225" w:rsidrDefault="008E1225"
wirside="008E1225"><w:pPr><w:pStyle w:val-"Headingl"/></w: PPra><wir><w: t>section 1.1: What's a
pipeline?</wi:t></wir></wip><w:p w:rside-"008E1225" "008E1225" sidrpefault="008E1225"
w:rsidP="008E1225"><w:pPr><w:spacing w:before="100" w: ULﬁgpaCllq 1" w:after="100"
afterAutospacing="1"/><w:rPr><w:rFonts w:ascii="Times' ,i "Times" w:cs="Times New Roman"/><w:sz
"20"/><wiszCs wival-"20"/></WirPr></wipPr><w:r w:i:rsidrPr-"008E1225"><w:rPr><w:rfFonts
"Times" w:hAr "Times" w:cs="Times New Roman"/><w:sz w:val="20"/><w:szCs
wival="20"/></wirPr><w:t xml:space-"preserve">At a high level of abstraction, a pipeline is what you get
whenever the output of one process feeds into the input of another. If you work with XML, you've probably
already used pipelines even if you didn't think about them in those terms. </Wit></W:r><w:proofErr
W Lvre "gramStart"/><w:r w:rsidRrRPr 00851225 ><WirPrr<w: rFonts w:ascii="Times" \nsi="Times"
w:cs="Times New Roman"/><w:sz w:val="20"/><w:szCs w:val="20"/></wi:rPr><w:t xml:space="preserve">If you
validate a document and then transtorm it, or if you apply </w:i:t></w: re<w: prootErr
w:type="spellstart"/><w:r w:rsidrRPr="008E1225"><w:rPr><w:rFonts w:ascii="Times" w:hAnsi="Times"
w:cs="Times New Roman"/><w:sz w:val="20"/><w:szCs

vival "20"/></w rer><w:t>XInclude</w:t></w: r>ew: prootBrr w:
W lgld?“l "008E1225"><w: rPr><w rFonts w:ascii="Times" nsi="Times" w:cs="Times New Roman"/><w:sz
wival="20"/><w:szCs w:val="20"/></w:rPr><w:t .ml.aracc ‘preserve > and then validate, or if you use XSLT
to run two <fwit></w: r<w: prootErr witype="spellStart"/><w:r w:rsidrRPr="008E1225"><w:rPr><w:rfFonts
W ii="Times" nsi="Times" w:cs="Times New Roman"/><w:sz w:val="20"/><w:szCs
al="20" /></w rPr><w t>ditteren</w t></w: r><w proo!Err w:type="spellEnd" /><w:r

3idRPr "008E1225"><w: rPr><w rFonts w:ascii="Times" w nsi="Times" w:cs="Times New Roman"/><w:sz

WiV "20"/><w:szCs w:val="20"/></w:rPr><w:t xml: space "preserve"> transformations, those are all simple
pipeline" operations.</w:t></w:r><w:proofErr v "gramgnd" /><w:r
rsidrPr="008E1225"><w: rPr><w rFonts w:ascii=" hAnsi="Times" w:cs="Times New Roman"/><w:sz
al="20"/><w:szCs "20"f></wirPrr<w:it xml: preserve"> </w:t></wir></wi:p><w:p
sidr="008E1225" w idrPr="008E1225" -sidrDefault="008E1225" ":rsid~ "008E1225"><w:pPr><w:spacing
before="100" befor ‘uLng:acinq "1" wrafter="100" w:afterfAutospacing="1"/><w:rPr><w:rFonts
ii nsi="Times" cs="Times New Roman"/><w:sz w:val="20"/><w:szCs
OR "20" fr< e rPr></w PPr><w: :rsidrPr="008E1225"><w:rPr><w:rFonts w:ascii="Times" w:hAnsi="Times"
w:cs="Times New Roman"/><w:sz w:val="20"/><w:szCs w:val="20"/></w:rPr><w:t xml:space="preserve">In
another context, pipelines are a common feature of Unix command lines, for example:
</w:t></w r></w:p><w:p w:rsidr="008E1225" w:rsidRPr "008E1225" w:rsidrRDefault="008E1225"

: "00851225"><w pPr><w padr><w top u.;al single w:sz="4" w:space="1" w:color="auto"/><w:left
single WiSZ ? "4" w:color="auto"/><w: bottom w:val="single" w "4" w:space="1"

"auto"/><w:right w val "single“ wisze"4" wispace="4" w:icolor-"auto"/></w:pBdr><w:tabs><w:tab
"left" w:i:pos="916"/><w:tab w:val="left" w "1832"/><w:cab W
"left" w:pos="3664"/><w:tab w:val="left" "4580" /><w:tab
"left" w:i:pos="6412"/><w:tab w:val="left" "7328" /><w:tab "8244" /><w:tab
"left" w:i:pos="9160"/><w:tab w:val "lett" "10076" /><w:tab 52"10992" /><w:tab

W
W

-
4

)|

type spellEnd /><w r

w

we

1

"left" wi:pos="2748"/><w:tab
05-"5496" /><w:tab

"left" pos "11908"/><w tab w:val="left" w:pos "12824"/><w tab 5="13740"/><w:tab

g "left" pos="14656" /></witabs><w:rPr><w:rFonts w:ascii="Courier" w:hans courier

w:iCs Courier"/><w sz w:ival="20"/><w:szCs w:val="20"/></wirPr></w: pPr)(w proo!Err

witype="gramstart"/><w:r w~rg1d<~1 "008E1225"><w:rPr><w:rFonts w:ascii="Courier" w:hAnsi="Courier"

wicse"Courier"/><wisz w:val-"20"/><w:szCs w:val "20"/></wirPr><w:i:t>cat</w:i:t></w:r><w:proofErr

type="gramgnd" /><w:r w:rsidrRPr="008E1225"><w:rPr><w:rFonts w:ascii="Courier" w:hAnsi="Courier" k&
courier” [¥ ¥

:cs="Courier" /><w:sz jal="20"/><w:szCs w:val="20"/></w:rPr><w:t xml:space="preserve"> ch0l.xml
</w t></wir><w:proofErr w:type-"spellStart"/><w:r w:rsidrRPr="008E1225"><w:rPr><w:rFonts w:ascii

v

'Iﬁ!!!ll Grid | Author |
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: Example

Both the Themes gallery and the Quick Styles zallery provide reset commands so that you can always
rastore the look of your document to the original contained in your current templatz. On the Insert tab,
the galleries indude items that are designed to coordinate with the owerall look of your document. You
can use these galleries to insert tables, headers, footers, lists, cover pages, and other document building
blocks. When you create pictures, charts, or diagrams, they also coordinate with your current document
look. You can easily change the formatting oﬁ!hmd text in the document text by choosing a look for
the selectad text from the Quick Styles gallery on the Home tab. You can also format text directly by
using the other controls on the Home tab. Most controls offer a choice of using the look from the
current theme or using 2 format that you spedcify directly. To change the overall look of your document,
choose new Theme elements on the Page Layout tab.

\.

Try it yourself
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O00 Editing HTML with TinyMCE
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Chapter 1. Introduction
In this chapter, we'll fill In some background about plpelines and get you up to speed on the concepts before we dlive Into the actual features of XProc.
We're going to assume that you're familiar with XML: you're comfortable the vocabulary of tags and attributes, parsing and valldation, and that you've
used an XML application or two: XSLT, for example.
1. What's a pipeline?
At a high level of abstraction, a pipeline Is what you get whenever the output of one process feeds Into the Input of another. If you work with XML, you've
probably already used plipelines even If you didn't think about them In those terms. If you vallidate a document and then transform It, or If you apply
XInclude and then valldate, or If you use XSLT to run two differen transformations, those are all simple “pipeline” operations.
In another context, plpelines are a common feature of Unix command lines, for example: \ )

cat chOl.xml | grep "
What that says Is:
1. Run the cat command over chol.xml. That will display the contents of the file.

2. The“|" symbol means that Instead of displaying those lines In the shell window, that output will become the Input to the grep command. What
grep will do Is display all the lines that contaln " and discard all the rest.

3. Finally, with another "|”, the output of grep will become the Input to we. The we command counts the words In a file, but we gave It the -1
optlon, so It will count the lines Instead.

What this pipeline does Is print the number of paragraphs In the document:
??FIXME: ??

By using a plpeline we've taken three useful utllities and composed them together to create a pipeline that will count the approximate number of
paragraphs we've used In all the XML documents In the current directory. I say approximately because those are all line-based commands and XML Isn't
really line based. Our XML editor might have saved our XML flles with great big long lines so that there's more than one ".." per line which would throw
off the counts.

Part of the power of Unix comes from the fact that It provides a large and useful vocabulary of focused commands and a mechnanism for easlly
composing them. By the same token, the XML technology stack provides a large and useful vocabulary of “commands”: parsing, valldation,
transformatlon, XInclude, XML Base, escaping and unescaping markup, document comparison, etc. What's historically been missing Is a standard, easy to
use composition mechnalsm.

Which Isn't meant to suggest that XProc Invented the notion of XML plpelines. Far from It, In fact. For as long as there have been APIs for processing
XML, there have been mechanisms for constructing pipelines. One of the explicit goals of the XProc development exercise was to Invent as little as
possible: the committee attempted to survey the landscape of exlIsting pipeline technologles and standardize the common core. The key features that
XProc Introduces are standardization and ease of use.

Through standardization we hope to foster the development of Interoperable pipelines. The pipelines that you run In your web framework should also run
on my command line and the plpelines that run on my command line should also run In your XML editor.

The ease of use goal Is met, we hope, by providing an XML vocabulary for describing plpelines. That's what XProc really Is. We hope that an analogy with
XSLT Is apt. Before XSLT, It was obviously possible for programmers to transform XML documents. What XSLT provided was an XML-based model that
opened transformation up to a much wider audlence. Many people who are able to write XSLT transformations would not feel comfortable writing a
transformation application In a standard programming language.

Before XProc, It was obvlously possible for programmers to bulld XML pipelines. What XProc provides Is an XML-based model that we hope will make It
possible for a much wider audlence to take advantage of the benefits of focused tools, loosely connected through pipelines. The fact that many projects A
developed thelr own vocabularies for exactly this purpose makes us optimistic that having a standard mechanism will be widely successful. v

Path: div.chapter » div.chapter-titlepage » h2
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Aside: (X

Or, “is this what we mean by XML!?”



(,) chapterl.html x

& 2 C (@ view-source:file:///tmp/chapterl.html WA O Oe U X

15 <div class="chapter" id="introduction"> ‘a
16 <div class="chapter-titlepage">

17 <h2>Chapter 1. Introduction</h2>

18 </div>

19 <p>In this chapter, we'll fill in some background about pipelines

20 and get you up to speed on the concepts before we dive into the actual
21 features of XProc. We're going to assume that you're familiar with

22 XML: you're comfortable the vocabulary of tags and attributes, parsing
23 and validation, and that you've used an XML application or two: XSLT,
24 for example.

25 </p>

26 <div class="section" id="whatis">

27 <div class="section-titlepage">

28 <h3>1. What's a pipeline?</h3>

29 </div>

30 <p>At a high level of abstraction, a pipeline is what you get

31 whenever the output of one process feeds into the input of another.
32 If you work with XML, you've probably already used pipelines

a3 even if you didn't think about them in those terms. If you validate
34 a document and then transform it, or if you apply XInclude and then
35 validate, or if you use XSLT to run two differen transformations,
36 those are all simple “pipeline” operations.

37 </p>

a8 <p>In another context, pipelines are a common feature of Unix

39 command lines, for example:

40 </p>

a1 <div class="screen"><pre xml:space="preserve"><span class="linenumber">

1</span><span class="linenumber-separator"> </span>cat chOl.xml | grep "&lt;para” | wc -

1</pre></div>

42 <p>What that says is:</p>

43 <div class="orderedlist">

44 <ol style="list-style: decimal;">

45 <li>

45 <p>Run the <strong class="command">cat</strong> command over

a7 <tt class="filename">chOl.xml</tt>. That will display the contents of the
file.

48

49 </p>

50 </1li>

51 <li>

52 <p>The “|” symbol means that instead of displaying those lines in

53 the shell window, that output will become the input to the

54 <strong class="command">grep</strong> command. What <strong
class="command">grep</strong> will do

55 is display all the lines that contain “<tt class="literal">&lt;para</tt>"

56 and discard all the rest.

57 </p>

58 </1li>

59 <li>

60 <p>Finally, with another “|”, the output of <strong
class="command">grep</strong> will

61 become the input to <strong class="command">wc</strong>. The <strong
class="command">wc</strong> command

62 counts the words in a file, but we gave it the <tt class="option">-1l</tt>
option, so

63 it will count the lines instead.

64 </p>

65 </1li>

66 </ol>

67 </div> b

68 <p>What this pipeline does is print the number of paragraphs in the A

69 document: v

70 </p> P

]
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What do we mean by ec

Or, “what was that driving question all about?”

"
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® You and me?
® Professional writers?
® Engineers?
® Interns?

® Managers?
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What do we mean by pec

®m XML experts

= T'll see your CDATA section and raise you an external parsed entity
®m XML users

® T'll see your empty element and raise you a processing instruction
m Users being presented with XML for the first time

® What's an XML?

n
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XML experts

® Understand the separation of content and presentation
® Believe in the value of structured markup
® Can leverage XML to deliver value

What editing problem?

n
.
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XML users

® Understand the separation of content and presentation
® Have been told about the value of structured markup
® May be seeing some value from structured markup

® May feel threatened by the loss of control

Possibly comfortable with oXygen/Arbortext Editor/etc.

n
.
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First time XMLers

® May have been told about the separation of content and
presentation

® May not understand the value of structured markup

® May be threatened or frightend by the prospect of changing
editing tools

® Probably think in terms of document presentation

Think everyone uses Microsoft Word.

]
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Aside: pre

® “Probably think in terms of document presentation”

n
L]
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The presentation problem

Fact:

® Many users consider their branded output as primary, XML as
secondary

Reality:

® Rendering arbitrary XML to high-quality print is hard

m “Lights out” formatting is fundamentally different than “by hand”
layout

® Automatically rendering arbitrary XML to an arbitrary design is at
least hard, if not impossible

n
.
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The other presentation proble

® The rise of desktop publishing, and the WYSIWYG word
processors that followed, have trained a generation (or more) of
authors to believe that the important thing about a document is
how it looks

® Authors believe that they add value by controlling the appearance
of the document

=
"
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Y

A tale of two e

In which the presenter rambles on a bit

n
.
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What will it take...

Education

]
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Editing XML

® Isn't harder just because the tools suck.

® It requires authors
® to think diffrently about content
® to know more about the content
® to unlearn a set of skills of which they may be rightfully proud and
for which they have historically been rewarded
® to accept that they have less control over the presentation
® It requires managers
® to change the structure of rewards for authors
® to accept that the problems are harder
® to understand that great rewards are possible, but they're not free

n
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Or did you mean....

What will it take to get

® An XML editor that provides a tailored user interface for any
vocabulary

® With a high-quality preview and “tags off” editing

® That supports semantic markup without any additional effort

® And can be used out-of-the-box without any customizaiton

n
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That will take

A miracle

]
.
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Conclusions

® For a lot of use cases and a lot of users, we have editors that
don't suck. Or at least, don't suck as much as you might at first
glance think they do.

® Tools like oXygen, Arbortext Editor (Serna, Altova, etc.) work
reasonably well for many kinds of users.

m If you're willing to squint at the XML a bit, tools like Word and
OpenOffice work today

® If you want to do better, it's as much about education as
technology

n
.
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